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1. Purpose

This standard operating procedure is intended as a summary of basic instrument
operation, including safety, sample loading, instrument settings, cell cleaning, and

sample disposal.

This SOP does not supersede the Perkin Elmer User Guides (hardware and software).
The full user guides include theory, all cautions, and detailed explanations of

parameters.
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2.

Overview

This SOP summarizes the steps to setup, acquire data, and export and process data
using the Lambda 800 UV-Vis. Where specific examples are shown we default to
transmission/cuvette operation.

3. Prerequisites
1. Use of the Perkin EImer Lambda 800 UV/Vis requires:
2. Becoming a user of RSC at http://rsc.aux.eng.ufl.edu/
3. Requesting training through http://rsc.aux.eng.ufl.edu/ccb/resource.asp?id=130.
4. Reading the full instrument manual and this SOP.
5. Successfully completing hands on training under the supervision of RSC staff.
4. Safety

In room 239: Do not cross the yellow and black tape on the floor, this area is designated
for mercury use. Should you need to enter this area, be sure to use the tacky floor mat

before leaving to remove any traces of mercury.

Do not attempt to bypass any instrument safety locks.

Safety glasses should be worn whenever you or others are preparing liquid or powder
samples or if the porosimeter is in operation. Safety glasses and gloves are supplied in

room 239.
5. Procedure
5.1 Preparation:

5.1.1 Instrument Preparation

Turn on the UV-Vis system using the power toggle switch located on the top of the
instrument housing in the back-right corner. System should be given
approximately 30 minutes to stabilize before use, to allow lamps and detectors to
stabilize before collecting data. You can turn on the system without being logged
in to the TUMI station.

5.1.2 Instrument Purging

For best accuracy on measurements below 190nm and water vapor adsorption, the
instrument should be purged with N>. For analysis using N, users will need to
make arrangements with RSC staff.
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5.1.3 Sample Preparation: Cuvettes

Realize that for liquids or solids measured in transmission there are both
absorbance and scattering phenomenon affecting the collected data. For best
absorbance data the solution/sample should be transparent throughout the
wavelength range. Recall, the maximum scattering occurs at flaws or particle sizes
approximately 2 the wavelength being scanned.

DI water is supplied (via gray faucets) for dilution. Disposable polyethylene
transfer pipets and kimwips are supplied in room 239 for use. Pipeters are
available, but precision is not guaranteed as they are multi-user tools. Users are
welcome to bring additional solvents/supplies for dilution; storage space in room
239 will be assessed on a case-by-case basis. See Section 7 for Waste Disposal.

5.1.4 Cuvette Selection
The RSC provides 4-sided polystyrene, 10mm path length cuvettes as well as 2-
sided low volume (10mm path length) acrylic or polystyrene cuvettes. It is the
user’s responsibility to ensure chemical compatibility with the cells/cuvettes in use
as well as wavelength range.
Polystyrene (PS): 340-800nm, Acrylic (PMMA): 280-800nm. (PS in rack look
slightly blue, PMMA are clearer to slightly yellow)
e Cells should be held by the top edges to avoid fingerprints on the optical
surfaces.
e Ensure there are no bubbles in the sample in the cell, bubbles will influence
results.

5.1.5 Sample Preparation: Integrating Sphere

Integrating sphere samples need to be a minimum of 1-inch diameter to cover the
sample port completely. No additional prep is required. Samples should not be
loaded until after the alignment is complete. Contact RSC staff if you have powder
samples or your sample does not meet the minimum dimensions.

5.1.6 System Startup

The desktop computer user UVV Administrator requires no password to log on.
Open “PerkinElmer UV WinLab” on the Desktop (Figure 1). If you have just turned
on the instrument, wait at least 1 minute before opening the UV WinLab software.
Select Analyst from the user name selection dropdown (Figure 2).
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UV WinLab
Data Proc...

Figure 1: PerkinElmer UV WinLab program icon.
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Figure 2: Startup of UV WinLab program.

See Page 42 of the software user guide for detailed explanations of buttons and
basic software functionality. The Software guide is available for reference
C:Users/Public/Public Documents/PerkinElmer

5.2 System Alignment:
RSC staff will attempt to keep the module status (Cuvette or Integrating Sphere)
updated on the tool status page. If you need the module changed please contact a
staff member to assist with the change.

5.2.1 Cuvette Loading and Alignment
e Fill two cuvettes with your base solvent (reference), cap them and load them
into the cuvette holders (shown in Figure 3), close the lid to the sample
compartment.
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o With plastic cuvettes, the face of the cuvette (side with the arrow) should
be facing to the left, towards the direction of the beam, as you insert.

e Only stoppered cuvettes should be loaded into the machine. If a spill occurs,
blot immediately to avoid liquid damage to interior coating. Do not rub or
scrub the black coating, do not try to remove any existing spots.

e With glass or quartz cuvettes, ensure orientation is preserved between
calibration and analysis.

e Sample cell windows are Silica, an optical component, do not touch the
windows, and do not attempt to clean the windows. Should a splash or spill
occur on or near a window, optical lens wipes must be used for cleaning.

Reference (back position)

Sample (front position)

Figure 3: Interior view of the UV-Vis Cuvette Module.

Alighment
e Ensure proper beam alignment by using the Align icon in the top menu bar,
shown in Figure 4.

£ UV WinLab - Run - Testl Monday, Novernber 25, 2019 2:50 PM Eastern Standard Time =N = =)

Fle Edit View Data Collection Tools Help
> L% m|e
Start Seth  Autozercgll Align

Slit width
2.00 nm

L Is5o.oo nm  0.0059 A

Figure 4: Align icon and tool status.

e To do this, select Align. The button will go gray and not allow you to select
again until the alignment has finished and the beam is now ON.
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Wait until alignment has finished, machine is Idle, to check the location of
the beam.
o You may find it helpful to place a piece of paper behind the cuvette to
observe the light passing through the cuvette.
e Adjust the cuvette’s position using the adjustment knobs shown in Figure 5.
e Deselect the Align icon when finished.
e Do not remove cuvettes, they will be used again later.

Figure 5: Cuvette alignment knobs.

5.2.2 Integrating Sphere Loading and Alignment

Figure 6 shows the Integrating Sphere and the sample and reference ports. Be
sure to always wear gloves when handling the reflection standards. The cover over
the sample reflection port is covered by a magnetic case, pull gently to access the
port, and ensure the cover is replaced before beginning the analysis.
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The sample holders are spring secured holders. Gently pull back the top of the
metal frame, slide the sample into position, and secure by slowly lowering the
frame. The central O piece should adjust to secure the sample flush against the
port. For alignment, you will want a piece of paper covering the transmission port
and the reflection standard port.

Alighment
Ensure proper beam alignment by using the Align icon in the top menu bar

(Figure 4).

To do this, select Align. The button will go gray and not allow you to select
again until the alignment has finished and the beam is now ON.
Wait until alignment has finished, machine is Idle, to check the location of

the beam.

o You will want to check the beam position by placing a piece of white
paper into the spring sample holder in the transmission position, and
the reflection standard position.

o Check that the beam is a rectangular shape and not being cut off by
the sample holder in both the sample beam path and the reference

beam path.
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5.3

5.4

e Alignment of the integrating sphere should only be done by RSC staff. If you
determine the beam is out of alignment, please notify staff for assistance.

e Deselect the Align icon when you have confirmed the proper beam position
to turn off the beam.

e Load your baseline correction standards into the ports, you should be using
2 pure white samples for this baseline, one loaded into the reflection
standard port, and the second into the sample reflection port.

o Remember to wear gloves when handling the reflection standards. The
standards are located in the cabinet above the tool.

Definitions:

A Method is analogous to a “procedure”. A Method defines the wavelength range,
the slit width, and other instrument parameters.

A Task is an experiment run using a Method.

For example, you might take a series of spectra, changing the polarity of the
samples each time. Or, you might have a series of spectra, each of a different
concentration of analyte. You use the same Method, but store the data as a Task.

Setting up the Method:

To begin, you will need to create and save a method, or open and edit an existing
method. For a quick and simple scan you can open the Scan method with the
shortcut on the far left toolbar. Otherwise follow the directions below to create or
edit the analysis type you need:

5.4.1 Create New Method
e Click File -> New -> Method (Figure 7)
e Select <High performance UV/VIS NIR Instrument>, click <Next> (Figure 8)
e Select <Lambda 800>, click <Next>
e Select a method type and click <Next>
o Scan- scanning spectra
Timedrive- measurements over time (kinetics)
Wavelength quant- see manual
Scanning quant- see manual
Wavelength program- see manual
o Polarization scan- see manual
e Select accessories: Leave blank, click <Next>
e Check the “Edit on completion” box, click <Save/Finish> (Figure 9)

©)
@)
©)
@)
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e Save to your user folder in the given format <NAME_Sample Name> (e.qg.,
Peterson_SiN on Silicon). Please do not save in the general methods folder.
If space needs to be made on the computer, methods whose purpose or

ownership is unclear will be deleted first.

Once saved, your method will open in a new window.

5 UV Winlab Explorer =lla=s
File Edit View Tools Help
T @ > A B X
New View Run cut Paste Delete  Manual Contral  Views
[B] Method
Instrument
f— , st X | Mame Type Modified on | Modified by | Stzmsl
B report Tempate Eth“ds [ High Performance Instruments Public folder Thursday, March 15, 2018 12:10 PM Eastern Daylight Time  PerkinElmer Service Personnel
cport Templ
= ACE [} 5can - Lambda 500 Scan Thursday, March 15, 2018 12: 10 PM Eastern Daylight Time  PerkinElmer Service Personnel  Predefi
£ Folder = Exemple Method edrive -Lambda 300 Timedrive Thursday, March 15, 2016 12:10 PM Eastern Daylicht Tme  PerkinEimer Service Persnnel  Predefi
) (=] i - N
tE] shortaut Group Service Methods | 75 wavelength quant - Lambda 500 Wavelength quant  Thursday, March 15, 2018 12:10 PM Eastem Daylight Tme ~ PerkinEimer Service Persannel  Predefi
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(D Instruments [Agwavelength program - Lambda 800 Wavelength program  Thursday, March 15, 2018 12:10 PM Eastern Daylight Time  PerkinElmer Service Personnel  Predefi
(& Queries [ Polarization scan - Lambda 800 Polarization scan Thursday, March 15, 2018 12: 10 PM Eastern Daylight Time  PerkinElmer Service Personnel  Predefi
[E] Report Templates
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.
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Figure 7: Creating new method.
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Mew Method Wizard

New Method
Wizard

Select instrument type
Selectinstrument
Select method
Sampling accessories
Finish

55
Welcome to the New Method Wizard

Select type of instrument

High performance UW/Vis/NIR instrument w
Medium performance UV instrument
High performance UW/Viz/NIR instrument
This instrument type covers the following instruments -
Lambda 1050
Lambda §50
Lambda 350
Lambda 750
Lambda 650
Lambda S00
Lambda 500
< Back [ Mext > J ’ Cancel ]

Figure 8: Selection of instrument during new method.

Mew Method Wizard

New Method
Wizard

Select instrument type
Selectinstrument
Select method
Sampling ac

Finish

55
Finish

Properties of method -

Method Type -Scan
Creation Methad - Methad wizard
Developed for instrument
Type -Lambda 800
Name -Lambda 800
Serial Number -101N1063001
Port -COM4
ACCESs0ries
None

Edit On Completion
D Make method available on Desktop
Add Desktop shertcuts to all users

[ < Back ][ Savex’Finish] [ Cancel

Figure 9: Finalizing new method properties.

5.4.2 Open Saved Method

e Navigate to existing method from the WinLab explorer window
e Single click to display method file metadata
e Double click to open saved method
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5.4.3 Open an Example Method
e In WinLab explorer data tree (folder list) Methods> RSC
o The RSC folder contains templates for the example methods outlined in
the Software guide (page 103 of Software guide).
= Note: The following example methods had a scan range outside the
limitations of the machine and were adjusted to the maximum 900 nm
wavelength.
= Camouflage Using Integrating Sphere
» Measurement of Glass and Architectural Materials to EN410
» ASTM E 892-87 Terrestrial Solar Irradiance
e The manual contains suggested settings and descriptions to use for the

example methods.

If editing a previously used Method, use the Save As option to save as a new
method and not overwrite any existing methods.

5.4.4 Analysis Setup

The setup is the same for scans using the cuvette holders or the integrating
sphere, and despite the illustrations not changing, scans using the integrating
sphere will run correctly following this setup.

Select Data Collection under folders list to adjust the measurement parameters
shown in Figure 10.

a. Method Settings: Scanning Range: Scans from higher to lower wavelength
o Available wavelength: 175 - 900 nm

b. Method Settings: Scanning Intervals/Speed: How much data to be received
o Data interval range: 0.01 - 10 nm
o Ordinate mode options: A (absorbance), %T (transmittance), E1 (energy

from sample beam), E2 (energy from reference beam), %R (reflectance)

c. Cycles: Number of Scans/Interval

d. Monochromator: Wavelength of pure light desired

e. Slits: Adjust the slit size

f. CBM: Adjusts the beam height to match different dimension samples

g. CBD: Beam correction for instrument polarization in birefringent samples

h. Attenuators: Adjust when measuring on high absorbing samples

The Program page is an “expert mode” that allows you to create a custom setup of
the instrument. The following settings are available for programming: UV/Vis
detector response, UV slit width, sample beam attenuator, and reference beam
attenuator. The respective items must be set to "Programmed” on the Data



Research Service Centers

UF

Perkin Elmer

Page 12 of 18

UNIVERSITY of FLORIDA Lambda 800 UV/Vis SOP Rev. No 2
https://rsc.aux.eng.ufl.edu g(ID_Z(ftOOl Iii\}sglsoezvoleW/Update:

Collection page to define settings on the Program page
(page 417) for additional information.

. See the Software guide

£ UV WinLab - Run - Testl Monday, Novernber 25, 2019 2:50 PM Eastern Standard Time =8 =8 =)
Fle Edit View DataCollecton Tools Help
> O » &
Start Seth Autozero  Align
Idle Slit width
650.00 nm 0.0059 A
2.00 nm
F“'“ia&’ L=t * D2 Lamp External Lamps Tungsten Lamp Method Setiings
= Task
= _ From
ommerm| e ® a. E
. -LEl program - A0 [ [nm]
i ey Accessory
% Comections Dt Interval Ordinate taode Scan Speed
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H Output S
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e
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° _y E >
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Figure 10: Data Collection tab of WinLab, this is used to designate system settings and to perform

alignment.

-

Notice: It can be helpful to attenuate the reference beam path in high
absorbance materials so that the reference signal does not swamp the
desired signal for analysis. Note the attenuator setting in Figure 10.
1) Enter the Data Collection tab in the software
2) Set the attenuator on the reference beam path to 10%

N

J
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If the settings specified in a method do not match the current instrument
configuration, an error message will appear when opening the method as shown in
Figure 11. Click <Edit Settings> to modify the method for use; the settings that
need to be adjusted will be highlighted in red in the Data Collection and Program
tabs (Figure 12).

Instrument Settings

The settings specified in this method do not match the current instrument configuration

‘®| Setting | Problem |
k. 4 Instrument Type Instrument changed
Common Beam Depolarizer Hardware missing

This method cannot be performed with the current configuration

[ Edit Settings ] [ Stop Now ] [ Edit Offine ]

Figure 11: Error message for incorrect instrument settings.

D2 Lamp External Lamps Tungsten Lamp Method Settings

Frarm To
250000 °

r_Y
w inm) 250,00 = )
Drata Interval Ordinate Mode Scan Speed
10.00 2 i) ZT - 122433 [nmdmin)
— Lamp Change
[
W g )

320 B
Cycles
Meonochromator 1

L) - 1] [rm) (0) &3 fast as possible
/] o1
Tt

Figure 12: Highlighted setting that does not match the instrument configuration.

= Mumber of cycles

Id

Select Sample Info under folders list to enter the number of samples you have for
measurement as shown in Figure 13.

5 UV WinLab - Edit - Testl ===
File Edit View DataCollection Tools Help
i~
= B G
Open Copy Paste
Initializing...
)
Falder List x
=[] Method
25 Data Collection 5 Samples
Bl Program
: Sample ID Description Type
1| Fluorescein Sample
- 2 Sample2 Sample
% Processing 3 Sample3 Sample
5 Results 4 Sample4 Sample
-] Output 5 Samples Sample

Figure 13: Sample info table.
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Next, go to Output under folders list and select <Print to file> and <Output to
file>. Click the setup option for <Data Export>. You will now get a pop-up page
<Export Data> as shown in Figure 14; select all boxes of interest. If applicable,
change the <Spectrum Export File (Raw)> and <Spectrum Export File
(Processed)> from .SP to .ASC.

Folder List x Repoit Template
=[] Task
= % Data Collection IDeIta E frev. 1] EH Export Data @

Program Set data export options

Repart Frequency

A
ey [ KA {0,045 araphic arts/ DL048 texties) B
i I Corrections ID 4 d ) )
: @ s acea) 1 K2 (0,015 graphic artsd 0.014 testiles)
ample Info
-3 Processing Output -0 s
Frint hardcopy Ol su
-[¥] Equation_2
Prink to file .[7] Equation1_3
Data Expart Equationt_4
[¥] Equation2
Output to file
[ EquationZ_1
Call Application Equationz_2
List of programs to execute after each sample --EE Custom Table
[ Exscutabls Path Cormmary = " Flows
L[ anRows
= Spectral Data
el - Data
e i |
- Spectrumn Export File [procetls 3
Ensue compatibility with previous versi - %v Data (raw] Samples by '3??
Suppress sample prompts 1 sv Data (processed) Samples by Columns -
Command placeholders can be used with auto Festore Defaults...
At end of run the curment sample is the last samy

Figure 14: Export data window.

Now click the setup option for <Output> and browse for your destination folder
(Figure 15), typically Computer/USER’s Documents/<Folder with your name>.

The software is now ready for analysis.
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Figure 15: Output setup window for saving results.

5.5 Analysis:
When ready to continue, select the orange Start button at the top of the screen.

WinLab prompts you to remove samples to perform a 100%T or 0%A
correction. NOTE: DO NOT REMOVE THE REFERENCE CUVETTES OR
REFLECTION STANDARDS.

You are correcting here for any mis-match in your reference and sample
cuvettes. This background scan is recorded and then used as the baseline for
all subsequent measurements using this method.

Click ok to perform the autozero.

When prompted, remove the cuvette in the sample position (or standard in
the reflection position), and place your sample in the appropriate sample
position, and click OK.

To collect more than one spectrum with this method, click Sample Info in the
Folder List

a) Change the number of samples, rename samples with meaningful names
b) When you click the Start, the software will automatically prompt you to
change samples until all samples in the table have been run. The
background is usually only re-scanned when you change scan parameters.
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6. Analyzing and Exporting the Data

1. Format the graph to your specifications using the Format icons in the Results tab.

2. Click on Output in the Folders List to customize and print and set the report
parameters.

3. Click on Report (middle-top of the screen) to save it as an RTF file.

7. Waste Disposal

Waste disposal will be assessed on a case-by-case basis. Samples that are non-
hazardous can be disposed of in either of the sinks in room 239. Users that have
hazardous samples must notify staff prior to equipment usage so that staff can arrange
for proper disposal.

8. System Shutdown

1. In the Data Collection tab, uncheck the D2 Lamp and Tungsten Lamp before
closing the program (shown in Figure 16).

. Exit out of the data collection and analysis software programs. Be sure all
occurrences are closed.

3. Remove all samples and reference standards. Place reference standards in the box
and return to the cabinet above the tool.

. Turn off the power to the spectrophotometer using the toggle switch.

. Put the computer in sleep mode.

. Log off the instrument in the TUMLI.

N

o Ul h

A

‘DZ Lamp ‘ External Lamps Tungsten Lamp

Lamp Change
Em 200 o

|
Figure 16: Unchecked D2 Lamp and Tungsten Lamp on Data Collection tab.

9. References

1. PerkinElmer. (2013). UV WinLab Software User’s Guide. Waltham, MA.



U Research Service Centers Perkin Elmer Page 17 of 18

UNIVERSITY of FLORIDA Lambda 800 UV/Vis SOP Rev. No 2
https://rsc.aux.eng.ufl.edu g(l)_zgtom Iii\/sglsoezvéew/Update:

10. Negligence

It is expected from all authorized users of this instrument to follow appropriate and safe
operational procedures in the manipulation of components and operation of the system.
Oversight or negligence in the operation and use of this instrument will lead to charges
for repairs or replacement of damaged parts and components.

What is negligence - Lambda 800 UV/VIS
(NRF Room 239)

Includes but not limited to:

1. Shutdown without turning off external lamps (D2 and tungsten) first.
2. Chemical incompatibility between sample and cuvette.
3. Improper disposal of hazardous samples.

If you have any questions or concerns regarding the statements above, please contact a
member of the RSC staff for clarification.
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11. Quick Checklist
1. Inroom 239, do not cross yellow and black tape on floor, this area is designated
for mercury use.
Turn on power to UV/Vis to allow lamps to stabilize before use.
3. Login and start WinLab software.
Add reference cuvettes (cuvette module) or reflection standards (integrating
sphere module).
a. Remember to wear gloves when handling the reflection standards.
5. Perform alignment.
6. Open saved method or create new.
7. Adjust Data Collection parameters.
8. Enter Sample Info.
9. Select Output to select data to export and destination folder.
10. Select Start to run analysis.
a. Software will prompt you before performing correction for baseline, make
sure references are loaded.
b. Software will then prompt you for each sample.
11. Save results.
12. Uncheck D2 and Tungsten lamps before closing program.
13. Exit program.
14. Remove samples and place reflection standards back in cabinet.
a. Remember to wear gloves when handling the reflection standards.
15. Turn off power.
16. Logoff TUMI.




